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The mission of the SOAPware Cloud Service (SCS)

The mission of SOAPware’s Cloud Service (SCS) is to replace your local IT department and 
consultant by providing all your computing needs with a cloud computing service. 

Think about computing needs as a utility. You shouldn’t have to worry about how the water gets to 
your faucet; you don’t need to know about all the filtration systems, the pumps, the chemicals 
needed, the upkeep of the infrastructures of pipes, elevation grades and pressure differentials 
between the water treatment plant and your tap. What you do need and expect is to turn on the tap 
and receive clean, filtered, properly pressured water. When you turn on the light switch you don’t 
have to worry about generating your own electricity or how the power company safely delivers it to 
you at the correct voltage -- you just expect it to work.  We want you to have the same ease of use 
with your computing needs. You should not have to employ IT staff, or worry about hardware and 
software upgrades, backups, failover systems and high availability architecture systems. You 
should simply connect to your service and use it, and never have to worry about all the 
complicated technology that it takes to make for a smooth workflow.   

SCS offers a complete desktop replacement for you. No longer do you have to keep your 
workstations, servers, and software up-to-date -- we provide the entire desktop environment for 
you. Not only can we host SOAPware applications, but we can also host third party billing 
systems, office software suites, and almost any type of business application on our servers. We 
provide this with virtual servers that offer from 4 Gigabytes of memory to 16 Gigabytes. Data 
storage can be almost limitless. Our virtual servers utilize from 4 to 8 processor cores allowing for 
a multitude of applications to be run simultaneously without any performance degradation. We 
can keep your software updated at your request with our own highly trained IT staff, or by working 
with your third party vendors. In our environment, if hardware fails, your virtual server can be back 
up and running in hours rather than the days or weeks common to repair with traditional 
hardware. The connection to SCS is provided via two large, enterprise-class internet connections 
that maintain connectivity constantly, and security is assured with both physical and software 
security measures. 

By utilizing Microsoft’s Remote Desktop Connection Client, you don’t have to learn a new 
operating system, as the familiar Windows desktop is utilized allowing for fast acclimation. Local 
resources like printers and local hard drives can be accessed reliably and securely within the 
Remote Desktop Client. The copying and pasting of text or files from your local device to the 
server is also available.  One of the greatest benefits is that your desktop looks the same no 
matter where you connect -- from the office, home or out on the road. Your server is always 
available to you with no regard as to your physical location. This can be reassuring to those in 
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highly mobile environments, or areas with high risk to natural disasters.  Comfort can be found in 
knowing that no matter from where you are when you connect, your virtual desktop will always 
have the same look and feel. 

We can even help you with local client network setup. This can include leasing of equipment and 
consultation for selection of the proper hardware to connect to the virtual server; however 
specialized equipment is not needed as 99% of all Windows Operating Systems in the workplace 
already have by default the Remote Desktop Client installed. 

How can this be affordable? How can enterprise level service be offered at local network prices? 
It’s a matter of scaled economics. Let’s take that analogy of generating your own electricity: how 
expensive would it be to buy generators, fuel, transformers and special load balancing equipment 
to keep your facility running on clean reliable electrical power? A lot!  But the utility company does 
it on such a large scale that it can offer better quality and a consistency that would be 
unmanageable and unaffordable on an individual scale. The same principle of scaled economics 
holds true with our services. We purchase resources on a massive scale and allocate a portion of 
that to the virtual desktop, thus providing you with huge resources at a very reasonable price. 

And because of the centrality and architecture of our system, the operational costs are minimized, 
providing the backbone for the affordability of the SOAPware Hosting Service. 

It is our desire to remove both the cost and the technical barriers, so as to provide you with a 
service that’s dependable, reliable, and affordable.  We allow you to focus on what you do best, 
and not worry about unfamiliar technology.   
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Contact Information

Phone: 1-800-455-7627
Support Ticket: www.soapware.com/ticket

To see a detailed feature chart of SCS, click here.

http://www.soapware.com/ticket
http://www.soapware.com/products/
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Docu-Portal

Docu-Portal is a new module for SOAPware users which provides two major feature additions to 
the EMR:  (1) inbound and outbound faxing which is integrated with the chart, and (2) a secure 
patient portal for providing records to patients.  In addition, there are a host of additional 
communication, document editing, and document capturing features included in the Docu-Portal, 
such as secure messaging to non-patient contacts, screen capture, PDF editing and generation, 
and scanned document uploads.  Docu-Portal provides tracking of fax and e-mail 
communications and provides configurable individual and shared views to inboxes and sent 
items.  Docu-Portal has been developed for SOAPware by Updox.

Interface

Docu-Portal is viewed through popular browsers, such as Internet Explorer, Google Chrome, 
Firefox and Safari.  Depending on a user's configuration, Docu-Portal is accessible anywhere on 
the Internet or only within the user's SOAPware VPN.  An icon saved to the desktop will bring the 
user to the sign-in screen after set-up. The user can also keep Docu-Portal running in the system 
tray, so that the screen can be hidden, except when being used.  Small messages appear in the 
system tray to let the user know that Docu-Portal has a new item for the user to work.  The user 
can also choose to receive notifications on the user's desk or phone e-mail to alert the user to 
certain items.

*SCS Customers: If users are using the SOAPware Cloud Service (formarly SOAPware Hosting 
Service), users will follow the same instructions below on the VPS and not on the local PC.  

Requirements

Requirements = Java version 6, SOAPwareXchange 2010.1.X or above
Click Here, verify that all the aspects of the interface are installed & configured.

Docu-Portal Connector

When creating a Docu-Portal account, the user will be prompted to select an EMR, in our case 
SOAPware & a custom connector will be created for this interfacing between SOAPware & 
Docu-Portal, called the Docu-Portal Connector.  The connector is a file (soapware_hosted.jnlp) 

http://updox.com
http://java.com/en/
http://soapedia.mysoapware.com/030._Documentation/Integration/UPDOX/UPDOX_Setup_and_Configuration
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that is ran by Java, installed to Start > Programs > Docu-Portal Connector and has several 
settings that can be adjusted to assist the user with personal & EMR interaction with Docu-Portal.

The Connector

The Connector creates the link between the Updox Service Database & SOAPwareXchange.  The 
application logs into the account on Docu-Portal so that the user can send & receive requested 
documents/information from the local computer or SOAPware.

1.  Connection Information: The connection information contains the user's personal login 
information so that the connector can interface with Docu-Portal.  The Server Location setting 
(https://www.myupdox.com/udb) is generally never modified unless directed differently by 
SOAPware Technical Support.

2.  Save to Disk Options: The Patient Home Folder is the location on the local computer where 
the Patient Chart Directory File will be created. The option “Send to Disk”in patient associated 
actions will automatically create a series of sub-folders within this folder, as configured by the 
“Patient Folder Pattern”.  The Patient Folder Pattern directs the filing order and file naming of 
patient-specific folders which are saved directly to a user's computer (in addition to saving them in 
SOAPware). When users select a category at the time of filing the record, that category will 
become (or populate an existing) sub directory under the patient folder. For example, assuming 

https://www.myupdox.com/udb
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the home folder is C:\PatientData and the record is titled “Test File”, and it is associated with 
patient “Joe Smith” and categorized as “Radiology”, the default file pathway of (@LI@/@LN, 
@FN@) will create the following file location: 

C:\PatientData\S\Smith, Joe\Radiology\Test File.pdf

The following abbreviations are used to construct the actual folder path based on patient and 
action attributes:
    @LI@ – Labeled with the patient's last initial
    @FI@ – Labeled with the patient's first initial
    @LN@ – Labeled with the patient's last name
    @FN@ – Labeled with the patient's first name
    @ID@ – Labeled with the patient's account number
    @BD@ – Labeled with the patient's birth date

3.  Import Directory Options: Ordinarily, users do not change the SOAPwareXchange "In" 
Directory from the default setting.  This must match the "In" folder location of SOAPwareXchange, 
specified in the SOAPwareXchange "Set Locations" settings.  In addition, the Report Download 
Directory is ordinarily not changed from the default setting.  This must match the location 
SOAPwareXchange expects to find the files to be imported, as specified in the file sent by the 
Docu-Portal Connector to SOAPwareXchange for processing.

Docu-Portal for SOAPware

After the user's  Docu-Portal Account is created, when the user goes to login at 
http://www.Updox.com the user will be prompted to select the EMR, SOAPware in our case, then a 
file will begin to download (soapware_hosted.jnlp).  This file will be ran by Java & start the "Updox 
for SOAPware" Helper which includes all the same tools mentioned below in "Main Menu 
Explained" & a few others.

1. Open Docu-Portal Browser will take users to the login page of the practice Docu-Portal website 
or the main page if he/she is already logged in.

http://www.updox.com/
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2. Open Auto Upload Folder will open, on the user's  local computer, the folder associated with 
the "auto upload to Docu-Portal" function (default = C:\Documents and 
Settings\USER\SendToDocu-Portal).

Main Menu

Actions

Compose will allow users to create a document (w/ attachment) to send to a patient's chart in 
SOAPware, to fax to a contact in SOAPware, or send to another Docu-Portal enabled Practice.

Add File allows users to upload any file to the Docu-Portal so that it can be passed securely from 
patient, contact or SOAPware.

Capture Screenshot allows users to store a pre-selected area of what's displayed on a user's 
monitor in an image file; so that the user may edit it or send securely through Docu-Portal.

Open Image Editor opens a window allowing users to create an image similar to Microsoft Paint; 
when a image is being viewed a menu will appear above the image allowing users to edit the 
image using the same tools found in Image Editor.

Sign Out will log out the current user that is logged into the Updox Docu-Portal.

Tools

Change Password allows users to create a new password for the users' Docu-Portal User ID.

My Profile allows users to edit the Name, Address, Time Zone, Email, & Signature Image of the 
users' Docu-Portal User ID.

Usage Information allows users to view the usage & limits associated with the users' Docu-Portal 
Monthly Plan; Chart Imports, Email, Fax Pages, Portal Messages, Saves, Secure Messages, User 
Accounts.
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Clear Cache 

Admin

Manage Users allows users to manage users (view, edit or add) in the Docu-Portal Practice.

Practice Profile allows users to view or edit the practice information associated with Docu-Portal; 
Name, Address, Phone, Fax, & Settings.

Practice Portal allows users to enable or disable the Practice Portal; as well as view/edit the 
name displayed & the web address (for example: http://soapware_clinic.myupdox.com) used to 
access it from anywhere with web access.

Manage Templates

Edit Fax Coversheet allows users to view/edit the default coversheet used by all faxes being sent 
by Docu-Portal.  Certain Text, referred to as Marcos, are required for the coversheet to function 
correctly; {fromName}, {fromFax}, {toName}, {toFax}, {subject}, {instructions} are used by the faxing 
function so that it knows what fields to pull &  where to place it in a user's coversheet. 

Billing Information allows users to view the usage & limits associated with the users' Docu-Portal 
Monthly Plan, Bill Dates & amounts as well as edit Credit Card Information.

Connect to EMR

Help

General Overview links to the following PDF 
(http://myupdox.com/udb/files/help/ov...w_soapware.pdf) for a document describing the 
Docu-Portals usage.

Setup References links to the following PDF 
(http://myupdox.com/udb/files/help/setup_soapware.pdf) for a document describing how to link 
Outlook Mail, Gmail, Faxing Service, or MAC to you your Docu-Portal.

FAQ links to the following PDF (http://myupdox.com/udb/files/help/faq_soapware.pdf) describing 
many functions of the Docu-Portal.

Have an Idea for Us? allows you to send question or comments directly to Updox for review; 

http://soapware_clinic.myupdox.com/
http://myupdox.com/udb/files/help/overview_soapware.pdf
http://myupdox.com/udb/files/help/setup_soapware.pdf
http://myupdox.com/udb/files/help/faq_soapware.pdf
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Have an Idea for Us? allows you to send question or comments directly to Updox for review; 
pertaining to an idea, question, problem or praise.

Contact Us gives you contact information for SOAPware Support (1-800-455-7627x3)

What's New?

Takes the user to the following address (https://myupdox.com/udb/whats_new.html) where the 
user can find new features & bug fixes being added to Updox.

https://myupdox.com/udb/whats_new.html
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FAQ's
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Q: On the SOAPware Cloud Service, how do I control the size of my screen?  

A: A user is able to control the size of their screen on the SOAPware Cloud Service by accessing 
the display tab, where resolution settings can be chosen. 

Access the Remote Desktop Connection

 Click on Remote Desktop.

Options

Click on Options. 
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Display Tab

1. Click on the Display tab.
2. Set the absolute size or choose Full Screen, and the Colors depth.
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Some Considerations 
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Q: How do I logout/disconnect from my SOAPware ASP Server? 

 

A: There are different ways to logout/disconnect from your SOAPware ASP Server, and not all have 
the same effect.  

Below discusses the methods for logging out or disconnecting, and the effects of each on your 
session and data.

NOTE:  Logging out of SOAPware and disconnecting from the ASP Server are two distinct 
actions.  It is possible to logout of SOAPware while remaining connected to your ASP Server.

To logout of the SOAPware application, choose the menu option SOAPware > Logout or Exit 
SOAPware.
This method:

    * only closes SOAPware and has no effect on your ASP Server connection or any other 
application on your ASP Server.
    * will save all data you have entered into SOAPware.
    * is the recommended way to close SOAPware before ending your SOAPware ASP session in 
order to minimize the risk of data loss.

To Disconnect from your SOAPware ASP server : 

 This allows you to leave SOAPware and other applications running on your ASP Server when you 
disconnect.  SOAPware will continue to run on your server so that when you reconnect you can 
pick up your work in the same place.

If you plan to be away form the computer for a short time (such as when changing rooms), this is 
a simple way to make a new connection from another computer without having to shutdown all 
your open applications.

If you plan to be away from the computer for an extended period, it is highly recommended that 
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you Log-Off from your server rather than disconnect, due to potential data loss. (See the 
Logging-Off section below.) 

While you are disconnected, scheduled events (scheduled backups, maintenance, server 
updates, etc) or unscheduled events (hardware failure, emergencies, disasters) at the SOAPware 
data center could cause your ASP Server to reboot or close SOAPware, which will cause any 
unsaved data or documents to be lost. 

There are four ways to Disconnect from your server:

    * Clicking the Close Button in the upper right-hand corner of the Remote Desktop window.
    * Right-clicking the Remote Desktop window title bar and choosing Close.
    * Click the Start button on your ASP Server and choose Shutdown.  Select Disconnect from the 
drop down box and click OK.

If you plan to be away from the computer for an extended period, it is highly recommended that 
you Log-Off from your server rather than disconnect, due to potential data loss. 

Logging-Off is the recommended method to end your SOAPware ASP Server connection.  Your 
connection is closed properly and all changes made to your SOAPware ASP Server Desktop will 
be saved.

Closing SOAPware (and any other open applications) before Logging-Off your ASP Server using  
this method is the surest and safest way to minimize the possibility of data loss.

There are 2 ways to Log-Off from your server:

    * Click the Start button on your ASP Server and choose Log Off.
    * Click the Start button on your ASP Server and choose Shut Down, then select Log Off from the 
drop down box and click OK.
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Q: How do I import images into a chart via the Remote Desktop?  

A: The concept of importing images is very simple.  This process is documented for end-users 
who wish to transfer files from their local computer (client) to the SCS server (server), to import 
into SOAPware, or to utilize their virtual server as an online repository for documents.  In response 
to this need, we have responded with a utility called “DocTrans”. This small utility transfers files 
from the client’s computer to the server.  The files can then be transferred into SOAPware using 
SOAPware’s “Document  Importer” or transferred to a folder of the end-users choice.

Configurations 

Two quick configurations are needed to allow DocTrans.exe to work properly.

• Your local C:\ drive must have a folder with the exact name of “shstrans”  (C:\shstrans).  If you 
don’t have the knowledge or authority to make this folder, please see your system 
administrator. The folder on the server should already exist, if not please call support at 
800-455-7627.

• Configuration of the “Remote Desktop Connection” application is required for the 
DocTrans.exe to work.
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Local Resources

 

• Open the “Remote Desktop Connection” application on your computer (client).
• Make sure the “Options” button is click to display the “Option” tabs.
• Choose the “Local Resources” tab.
• Under the section “Local devices and resources” click the “More” button.
• Make sure your “C:\” drive is selected.
• Click “OK” and then back to the “General” tab.

Connect as you normally would, however, at this point you may receive a security notice that you 
are going to be connecting your drives to the Remote Desktop Computer.  This is expected, and is 
the function we want.  At this point, the configuration steps are finished on this PC & only need to 
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be completed once on each of the client computers you use.

 

Transfer Image/Document(s) to the VPS

• At this point, you have the folder created and the Remote Desktop Connection application 
configured to connect your “C:\” drive to the server.

• You can now save/drop any Image/Document(s) into the “C: \shstrans” folder on your local 
computer.

• Double-click the DocTrans application on the server desktop, and the contents of the SCS 
trans folder will be uploaded to the server.

• You will see a DOS window appear showing you that status of the image/document(s) 
transfer, once complete a window will appear displaying the contents of the C:\shstrans 
folder. 
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Importing the Image/Documents(s) into SOAPware

• Double-click the SOAPware Icon & login to SOAPware as you normally do.
• Once SOAPware is open, Click SOAPware > Document Import > the Document Importer 

Workspace will appear, which contains 4-panes to operate in: Chart Rack, Drive/Folder 
Selection, File Selection, & Chart Section.

• In the Chart Rack Pane, pick a patient > in the Drive/Folder Selection Pane, pick a location to 
browse for your files; in this example it would be C:\shstrans > in the File Selection Pane, 
select the file(s) you want & drag them to the Chart Section you would like them saved in.

• You have successfully imported your Image/Document(s) into SOAPware. 

Things to Remember

• The DocTrans will only transfer 10MB or less at a time. This protects you from using all your 
bandwidth for long periods of time.

• The DocTrans will overwrite existing files with the same name. For example if you have a 
scan called MRI.jpg in the server's C:\shstrans folder and you upload another file called 
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MRI.jpg, it will overwrite the first.
• The DocTrans only moves files from the clients C:\shstrans to the servers C:\shstrans, it 

doesn’t move them the reverse direction.
• The DocTrans places the documents on the server for easy import into SOAPware, it does 

not move them into SOAPware.
• Once a document has been moved into SOAPware with the “Document Importer” it can then 

be deleted from the server's C:\shstrans folder. This is actually encouraged as you don’t want 
to use all your free space on the “C:\” drive with documents.
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Q: How do I connect to the SOAPware Cloud server?  

A: The SOAPware ASP program allows for users to connect to the SOAPware application from 
anywhere in the world using Microsoft's Remote Desktop Connection Application.  RDC, as we 
will call it from here forward, is a tool for running a computer remotely. With RDC you can utilize 
our remote servers just as if you were sitting in front of it. There are RDC applications for almost 
every operating system, including Macintosh. 

Connect to the ASP server

1. Click on Start.
2. Click on All Programs.
3. Click on Accessories.
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4. Click on Remote Desktop Connection.

Enter the DNS (Domain Server Name) 

1. Enter the DNS (this will be supplied to the clinic contact person).
2. Click Connect. 

Login Screen

The next screen you will see is your log on screen. Here you will enter your user name and 
password to the VPS server. Each user name and password is unique for each server and each 
clinic has it's own server.
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Remote Desktop View

Once logged in, you will see a desktop much like your local desktop.  From here you can launch 
the SOAPware application or any other application you have purchased.  
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Q: How do I print from a Remote Desktop Connection (RDC)?  

A: Give a list of the printers in the clinic, to the Support Team at SOAPware. The Support team will 
then install the print drivers on the ASP server to make the printers available from the server. 
You may submit this information in a Support ticket at www.soapware.com/ticket.

After this step is completed, the option of  "printers" must be selected on the Remote Desktop 
Connection. 

Q: Access the Remote Desktop Connection 

1. Click on the computers Start menu.
2. Click on Remote Desktop Connection. 

http://www.soapware.com/ticket
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Local Resource/Printers

1. Click on the Local Resources tab.
2. Click to place a check in the box next to printers.
3. Click on the General tab.
4. Click on Connect to connect to the Remote Desktop.
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Q: How does a Remote Desktop Connection "Session" work?  

A:  Terminology for understanding "Session" concepts:

Session - An independent desktop environment capable of running a set of programs on a server 
with set permissions based on user name and passwords which persists regardless of outside 
connectivity.

Remote Desktop Connection - A Microsoft program that allows you to start, connect to or stop a 
"session".

Terminal Session - implies connectivity from the client (Remote Desktop Connection) to the 
server.

If a user logs onto the server and simply clicks the X to close the Remote Desktop Connection 
program, they have only disconnected from the server. In other words, they have stopped the 
Terminal Session. The environment or what is called a "session"   is still open and running on the 
server. All the programs that have  been opened are still running back at the server and as far as 
the server is concerned,  connectivity has been lost and it’s patiently waiting for to reconnection. 

The upside of leaving a session open is:

• The user can close this connection at the current computer, go to another computer and log 
back in with the same user name and password, and be right back in the "session" where 
they left it when they disconnected.

• The user doesn't have to wait for SOAPware to load, they simply log in.

The downside of leaving a session open is:

• That session uses up a terminal licenses, and the clinic only has a set number of them.      
• If for some reason the user has an unsaved encounter information or other unsaved data 

and the session is reset by another user whom logs in and unknowingly closes programs 
without saving, the server is rebooted or in the event of a server crash, that data will be lost.      

• If a user is   logged into SOAPware with high permissions, and someone with lower 
permissions logs into the session, they can see what the first user was  working on.  It's 
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important that session accounts and SOAPware accounts match in permissions.  For 
example, if the front desk staff only has the ability to pull a chart or create a new chart in 
SOAPware, the do not need the user name and password to the doctor or nurses Remote 
Desktop Connection Session. 

Note: It is our recommendation, when a user is  finished working in a session, at the very least, 
close the patient's chart (that saves the data) then log out of SOAPware (this keeps any of the staff 
without permission from seeing patient data).  

To log out of SOAPware click the menu item File >  Logout.

Leaving a session open is not in itself bad, as long as you have logged out of SOAPware by 
Clicking the menu item, File > Logout  The absolute safest measure is to Click the Task Bar's, 
Start > Log off buttons. Logging off the session closes all programs and releases the Terminal 
Session licenses.
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Q: How do I scan into SOAPware on the SOAPware Cloud Service? 

A:  Due to limitations with Windows, document scanners cannot directly scan into the SOAPware 
Cloud Service. However, there are some options:

Option #1
Scanners from Ambir Technology (an approved SOAPware Partner) are specifically designed to 
work with the SOAPware Cloud Service. These scanners have been tested and verified to work in 
the SOAPware Cloud Service environment. For more information, visit 
http://www.ambir.com/SOAPware. 

Option#2 
Click here for a lesson that goes over how to scan locally & import your Document(s) over to your 
SCS server for importing into SOAPware.

Option #3
There is third party software available that gives Windows Remote Desktop the ability to access a 
scanner from your local computer. The software programs listed below are currently being used 
by a number of SCS Users and SOAPware, Inc. has no complaints concerning their usage.

• TSScan - Remote Desktop Scanning by Terminal Works.
• RemoteScan by RemoteScan Corporation.

http://www.ambir.com/SOAPware
http://soapware.screenstepslive.com/s/documentation/m/shs/l/31731?resolve=true
http://www.terminalworks.com/remote-desktop-scanning/
http://www.remote-scan.com/
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Q: What controls the speed of my ASP server?  

A:  

The first, and most influential, factor is bandwidth. Bandwidth is the potential amount of data that 
can move across the Internet connection. Internet connections can be purchased from ISPs for 
amounts from 28.8 Kbps to 10Mbps. As with RAM or CPU speed, more is always better. 

Remote Desktop Connection (RDC) has the ability to fine tune the servers to accommodate a lack 
or abundance of bandwidth. In the RDC application under the "Experience" tab, are settings from 
the most limited connections (Modem 28.8Kbps) to the highest available (LAN 10Mbps or higher). 

In our tests we have found that most connections operate optimally at the Modem 56Kbps setting. 
Choosing a lower setting doesn't limit the connection speed, only the Experience. In fact, the 
lower the Experience setting, the faster the ASP server will seem to react and run, as it has to 
move less data over the Internet connection for any given task.

While it is possible to connect to the server via a 28.8 or 56 Kbps Modem, we have found that at 
least a 128 Kbps connection is needed for real-time interaction.

To optimize the connection, start off with the most basic settings possible, and gradually increase 
them until the server's reaction seems to slow down, then move back down to the previous 
setting. A good starting point is to set the connection speed to Modem 28.8 Kbps, the display to 
640x480, and the display colors to 256. 

The optimal configuration is a trade-off between perceived reaction times and display quality. 
Users may prefer different settings depending on their needs. 
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Q: Why won't printers load into a Remote Desktop Session? 

A:  When you connect to your SCS Server, and go to Start > Control Panel, > Printers and 
Faxes--and  nothing displays, this is a known Microsoft Windows XP issue and Microsoft has 
addressed it in a support article.

The reason for this behavior is that by default, Terminal Services only supports printer's that begin 
with COM, LPT, or USB.

The fix for this is fairly simple,  as you will need to follow the following 6 steps:

1. Click Start > Click Run>  type "regedit" >  and then Click OK.
2. Locate and then Click the following key in the registry: 

HKEY_CURRENT_USER\Software\Microsoft\Terminal Server Client\Default\AddIns\RDPDR
3. On the Edit menu > point to New > then Click DWORD Value.
4. Type "FilterQueueType", and then press ENTER.
5. On the Edit menu, Click Modify.
6. Type "FFFFFFFF", and then Click OK.

These steps allow all printer ports to be redirected inside Terminal Services/Remote Desktop.

To see the actual Microsoft Support document, Click here. 

http://support.microsoft.com/default.aspx?scid=kb;en-us;q302361
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